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3    Basics of Operation
3.1.  Introduction

This chapter will explain how to give commands to LIMDEP and some essential features of operation   The sections to follow are:


3.2:   Beginning the LIMDEP Session 


3.3:   Using the Editing Window

3.4:   A Short Tutorial

3.3:   Commands describes the format of LIMDEP commands;


3.4:   Command Files describes using files for batching commands;


3.5:   Work Areas describes the work environment in LIMDEP on your computer;


3.6:   Program Output introduces the subject of output and results files;


3.7:   HELP describes the available online documentation in the PC versions of LIMDEP;


3.8:   A Summary of Commands provides a full list of LIMDEP commands;


3.9:   A Summary of the Windows Desktop describes the set of menus and other parts


        of the LIMDEP desktop.

3.2.  Beginning the LIMDEP Session


When you begin your LIMDEP session by selecting the LIMDEP icon in the Start:Programs menu or the icon on your desktop, the initial screen will show a project window entitled Untitled Project 1 and an empty desktop as shown below in Figure 3.1.  You can now begin your session by starting a new project or reloading an existing one.  Figure 3.2 shows the File menu (the lower sections show some of our previous work - your own files will appear when you start LIMDEP on your own computer).

3.2.1.  Opening a Project

You can select Open… or Open Project… in the desktop menu (they are the same at this point) to reload a project that you saved earlier - a dialog box will open to proceed.  You can also select one of the existing projects known to LIMDEP (if any are) which are listed near the bottom of this menu.  These are all optional, and you may, instead, simply proceed to the session with a NEW... (empty) project. 
NOTE:  For a new session in which you intend to READ and process a data set that you have not already saved or put in a file with Save, you should not open a new project at this point.  The new  session is already an open project, and you may just proceed to build it.

NOTE:  In order to operate LIMDEP, you must have a project open.  This may be the default untitled project or a project that you created earlier.  You will know that a project is open by the appearance of a project window on your desktop.  Most of LIMDEP’s functions will not operate if do not have a project open.

       [image: image1.png]



        Figure 3.1.  The LIMDEP Desktop

TIP:  You can associate a LIMDEP project file (see Sections 2.6 and 2.7) with the program, and launch LIMDEP directly with your project file.  Use My Computer to navigate to the folder where you have created your project file – its name will be <the name>.lpj.  Drag the icon for the .lpj file out to your desktop then close My Computer.  Now, you can double click the icon on the desktop to launch LIMDEP and read the project file at the same time to begin your session.
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                                           Figure 3.2.  The File Menu
3.2.2.  Opening an Editing Window

To begin entering commands - there are other features you might use, but we assume you wish to begin here - you should now open an editing window.  Select New in the File menu to bring up the box shown in Figure 3.3.  Now, select Text/Command Document and OK in this box to open the editing window, which will appear to the right of the project window.
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                                          Figure 3.3.  The File:New Dialog Box

The desktop will now appear as shown in Figure 3.4, and you can begin to enter your commands in the editing window as we have done in an example in the figure.

If you have created a text file that contains LIMDEP commands that you will be using instead of creating a new set of commands, you can use File:Open to open that file.  If the file that you open has a .lim file extension in its filename, then LIMDEP will automatically open an editing window and place the contents of the file in the window.
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     Figure 3.4.  Project Window and Editing Window

Note that the editing window shown in Figure 3.4 is labeled “Untitled 1 *.”  This means that the contents of this window are not associated with a file; the commands in an untitled window are just added to the window during the session.  When you open a “.lim” file, the file will be associated with the window, and its name will appear in the window banner.

NOTE:  The title banners in LIMDEP’s windows use the Windows convention of indicating with a trailing ‘*’ that the contents of the window have changed but have not yet been saved.  The ‘*’ in the main banner for LIMDEP refers to the currently active window.  In Figure 3.4, the editing window is active and as yet unsaved, so the main program banner is marked ‘*.’  The project window (i.e., contents of the project) are not changed yet, so if this window were active, there would be no ‘*’ in the main banner.

TIP:  You can also associate a limdep command file, <the name>.lim, with LIMDEP.  As in the previous tip, if you use My Computer and your mouse to drag the icon for a .lim file out to the desktop, then you can double click the icon to start LIMDEP and at the same time, open an editing window for this command file.  Note, however, that when you do this, you must then either open an existing project file with File:Open, File:Open Project, or one of the menu entries, or start a new project with File:New/Project/OK.

3.3. Using the Editing Window


LIMDEP’s editing window is a standard text editor.  Enter text as you would in any other Windows based text editor. The Edit pull down menu provides standard Undo, cut, copy, paste, Clear (delete), Find, Replace, and so on and Go To…, which will allow you to go to a specific line in the editor.  You can also use the Windows clipboard functions, for example, to move text from other programs into this window, or from this window to your other programs.
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   Figure 3.5.  The Editing Window and the Edit Menu

There are other features that you can use with the editing window.  The Insert menu allows you to place specific items on the screen in the editor:


(   Insert:Text File will place the full contents of any text file you select in the editor at


     the nsertion point (where the cursor is t.  You can merge command files, or create


     command files, using this tool.


(   Insert:Command (or the button marked fx  that appears at the upper left corner of the


     editing window) will place a specific LIMDEP command (verb) at the insertion point).

 
    A dialog box will allow you to select the verb from a menu (with explanations) or build a


    model command from a full listing of the options available. 

(    Insert:File Path will place the full path to a specific file at the insertion point.  Several


      LIMDEP commands use files.  The dialog box will allow you to find the full path to a


     file on your disk drive, and  insert that path in your command.

TIP:  Under Windows 95/98/NT, file names must often be enclosed in double quotes for the operating system to find the file that you wish to use.  Insert:File Path will include the double quotes when it locates a file name.  If on occasion you find that LIMDEP is unable to find a file that you thought you had specified correctly, make sure that you have included the double quotes.


(   The small Insert Name window at the top of the editing window contains a complete


    list of the names of variables, matrices, etc. that appear in the project window.  You can


    select names from this menu to add to commands as you construct lists in the editing

 
     window.
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    Figure 3.6  The Insert Menu

TIP:  You can drag any name from the project window into the editing window  We’ll take a closer look at this below.

(  You can change the font to be used for the text in the editor.   Choose Tools:Options, then the

     Editor tab, and finally Choose font.  (This control also sets the font in your output window.)  


When you are ready to execute commands, highlight the ones you wish to submit with your mouse by pointing to the beginning of the first line you wish to submit and, holding down the left mouse button, move to the end of the last line you wish to submit.  This will highlight (by changing the text from black on white to white on black) the selected lines.  Then, to execute the commands you may do either of the following:

(  Click Go on the LIMDEP toolbar.  (If the toolbar is not showing on your screen, select the
     Tools:Options/View tab then turn on the Display Tool Bar option.)

(   Select the Run menu at the top of your screen.  The first two items in this menu are:
     (   Run will allow you to execute the selected commands once.
     (   Run Multiple Times… will allow you to specify that the selected commands are 

           to be executed more than one time.  The dialog box queries you for the number of 

           times.


The commands you have selected will now be carried out.  In most cases, this will produce some output.  LIMDEP will now automatically open the third window, your output window.  Output is discussed below.


There are two other ways to submit a command – these will usually just add a small bit of convenience.
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     Figure 3.7  Command Window and Editor Entry

Figure 3.7 shows a desktop with a new project open, some text in the editing window, and a notation in a small window beneath the row of buttons.  This shows two additional ways for you to submit commands which fit on a single line – many of LIMDEP’s commands will not:

(  You can type a one line command in the command window, then press Enter to submit it.  The

    small arrow/button at the end of the line allows you to recall and select among the last several

    such commands you have submitted.

(  (For desktop computer users – this does not apply to most laptop computers.  The two Enter keys

    on  your keyboard, one in the alphabetic area and  one in the numeric keypad, are different  from

    LIMDEP’s viewpoint.  You can submit a one line command the line with the cursor in it by pres-

    sing the numeric Enter key.  The alphabetic Enter key acts like an ordinary editing key.

NOTE:  If your desktop does not include the small command window, use Tools:Options… then click the Display command bar box to turn this feature on.  You will not have to do this again unless you turn it off yourself.  


Finally, the right mouse button is also active in the editing window.   The right mouse button invokes a small menu that combines parts of the Edit and Insert menus.  As in the Edit menu, some entries (Cut, Copy) are only active when you have selected text, while Paste is only active if you have placed something on the clipboard with a previous Cut or Copy.
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 Figure 3.8  The Edit/Right Mouse Button Menu

The first line, “Run Selection,” indicates that one or more lines is highlighted in the edit window, and if you make this selection, those lines will be submitted to the program.  If no lines are highlighted, this entry will suggest “Run Line” instead for the line which currently contains the cursor.

3.4.  A Short Tutorial
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                                                  Figure 3.9  A Windows Desktop
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     Figure 3.10  Initial LIMDEP Desktop

2.  Open an editing window.

Use File:New  then Text/Command Document to open an editing window, exactly as discussed earlier.
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  Figure 3.11  Opening the Editing Window
3.  Place commands in the editing window.


The commands shown below will do the following:


1.  Instruct LIMDEP to base what follows on 100 observations.


2.  Create two samples of random draws from the normal distribution, a “y” and an “x.”


3.  Compute the linear regression of y on x.

Spacing and capitalization do not matter – type these three lines in any manner you find convenient.  But, do use three lines.

                       [image: image12.png]4] Untitled 1 = [-[OIx]
Al et ]

sanple ; 1-1008
Create © X = Run(0.1) : ¥ = X + Ran(0.1) $
Regress! Ihs = ¥ ; Rhs = Ons.X §






        Figure 3.12   Editing Window

4.  Submit the first two commands.


Drag your mouse to highlight the first two lines of this command set.  Now, move the mouse cursor up to the (now) green button market “Go” – it is directly below Tools – and click the Go button. Note that a new window appears, your output window.
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  Figure 3.13  Output window with command echo

The output window will always contain a transcript of your commands.  Since you have not generated any numerical results, at this point, that is all it contains.

5.  Compute the regression.


Before doing this step, notice that the top half of the output window has the ‘Status’ tab selected.  Click the ‘Trace’ tab.  This will change the appearance of the top half of the window, as you’ll see below.  Now, select the last line in your command set, the Regress… command, and press the GO button.  The regression output appears in the lower half of the window, and you can observe the accumulating trace in the upper half of the window.  This trace in the top half of the window will be recorded as the trace file, TRACE.LIM when you exit the program.
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Figure 3.14  Regression output in output window

6.  The project window


Note in Figure 3.9, in the project window, that the topics Matrices and Scalars have [image: image15.bmp] symbols next to them, indicating that the topic can be “expanded” to display its contents.  But, the Variables entry is not marked.  After you executed your second line in your editing window, and created the two variables X and Y, the Variables topic was added to the tree and marked with [image: image16.bmp].  Click this symbol to expand the topic.
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Figure 3.15  Project window

Some other features you might explore in the project window: [image: image18.bmp]
(  Click the [image: image19.bmp]  symbol next to the Matrices and/or Scalars topics

(  Double click any name that you find in the project window in any of the three topics

(  Single click any of the matrix or scalar names, and note what appears at the bottom of the window.

7.  Exit the program


When you are done exploring, select File:Exit.  There is no need to save any of these windows, so answer no to the three queries about saving your results.

3.5.  Commands

There are numerous menus and dialog boxes provided for giving instructions to LIMDEP.  (They are described in detail at the end of this chapter.)  But, ultimately, the large majority of the instructions you give to the program will be given by commands that you enter in the text editor or by one of the other methods described in Section 3.3.  This section will describe the LIMDEP command language.  We begin by describing the general form and characteristics of LIMDEP commands. 

3.5.1.  Syntax

Commands are of the form:


VERB  ;  specification  ;  specification  ;  ...  ;  specification  $
The verb is a unique four character string which identifies the function you want to perform or the model you wish to fit.  If the command requires additional information, the necessary data are given in one or more fields separated by semicolons (;).  Commands almost always end with a ‘$.’  (A few minor exceptions are noted below.)  The set of commands in LIMDEP consists generally of data setup commands such reading a data file, data manipulation commands, such as transforming a variable, programming commands such as matrix manipulation and scientific calculation commands, and model estimation commands.  All are structured with this format.  Examples of the four groupings noted are:


READ ; File = “C:\WORK\FRONTIER.DAT ; Nobs=27 ; Nvar = 4 $


CREATE ; logq = Log(output) $


MATRIX ; identity = Iden(5) $


FRONTIER ; Lhs = logq ; Rhs = one,Log(k),Log(l) ; Model=Exponential $

Note that though the contents are

(    You may use upper or lower case letters anywhere in any command.  All commands are 

      translated to upper case immediately upon being read by the program, so which you use 

      never matters.

(    You may put spaces anywhere in any command.  (You may also use tabs in an input file.)

      LIMDEP will always ignore all spaces and tabs in any command.

(    Every command must begin on a new line.

(    The number of nonblank characters which precede the ending ‘$’ must not exceed 2,500.

(    In any command, the specifications may always be given in any order.  Thus,



   
READ 
        ; Nobs=100 ; File=Data.PRJ $

      and                             READ 
; File=Data.PRJ ; Nobs=100 $
      are exactly the same.

(    You may use as many lines as you wish to enter a command.  Just press Enter when  it is

      convenient.  Blank lines in an input file are also ignored.

(    Most of your commands will fit on a single line.  However, if a command is particularly long,

      you may break it at any point you want by pressing Enter.  The ends of all commands are indi-

      cated by a ‘$.’ LIMDEP scans each line when it is entered.  If the line contains  a $, the com-

      mand is assumed to be complete. 

HINT:  Since commands must generally end with a $, if you forget the ending $ in a command, it will not be carried out.  Thus, if you submit a command from the editor and ‘nothing happens,’ check to see if you have omitted the ending $ on the command you have submitted

3.5.2.  Naming Conventions and Reserved Names

Most commands refer to entities such as variables, groups of variables, matrices, procedures, and particular scalars by name.  Your data are always referenced by variable names.  The requirements for names are:

(    They must begin with a letter.   Remember that LIMDEP is not case sensitive.  Therefore,  you

can mix upper and lower case in your names at will, but you cannot create different  names with different mixes. E.g., GwEn is the same as GWEn, gwen and GWEN.

(    You should not use symbols other than the underscore (‘_’) character and the 26 letters and 10

digits in your names. Other punctuation marks can cause unexpected results if they are not picked up as syntax errors.

(    Names may not contain more than eight characters.


There are a few reserved words which you may not use as names for variables, matrices, scalars,  namelists, or procedures.  These are:


one

(used as a variable name, the constant term in a model),


b, varb

(used as matrices, to retain estimation results from all models),


n

(always stands for the current sample size),


pi

(the number 3.14159...),


_obsno

(observation number in the current sample, used by CREATE)


_rowno

(row number in data set, used by CREATE)


s, sy, ybar, degfrdm, kreg, lmda, logl, nreg, rho, rsqrd, ssqrd,sumsqdev




(scalars retained after regressions are estimated),


exitcode
(used to tell you if an estimation procedure was successful).


You are always protected from name conflicts which would arise if you try to give an entity such as a variable a name which is already being used for something else, such as a matrix or scalar, or if you try to use one of the reserved names.  For example, you may not name a variable S; this is reserved for the standard deviation of the residuals from a regression.  LIMDEP will give you a diagnostic.

3.6.  Input Files - Entering Commands from a File

Instead of using your text editor, you may submit a set of commands that have previously been placed in a file on your disk drive. An input (command) file is used to enter commands from a file.  Any command may appear in an input file.  


There are a few controls that will be useful in an input file.  When you use an input file, output such as model results that it produces will come to your screen in normal fashion just as if you had used the editor.  (The commands submitted from the editor are, in fact, treated as if they were an input file.)  

SILENT  dictates that visible output should be suppressed.  No output will be sent to your output window or to an output file.  You might use this if your commands were producing intermediate results to be collected in a loop and examined later.

Normally, you would want to type as little as possible to complete a command.  However, for purposes of documenting your commands in an input file or in your trace file, for example, so that you can review a session later, you might want to add commentary to your commands.  There are several ways to do so.


Although a verb has a minimum of four characters, you may put any text you like between a verb and the first semicolon or the end of the command if there are no specifications.  You may also put comments after the ending $ in a command.  Everything on a line after a $ is ignored. Thus, to specify a probit model, you might use



PROBIT Model ; Lhs = moved ; Rhs = one, age $  Migration model
You may also mark parts of your command lines as comments with a ‘?.’  On any line, any text which follows a ‘?’ is treated as  comment and ignored (as is the ‘?’).  For example,



LOGIT ; Lhs = occupatn                ? Job choices coded 0,1,2

  
         
 ; Rhs = one, age, region    $ 

Note, however, that if the $ appeared at the end of the first line, after the ?, LIMDEP would not find it because it would have appeared as part of a comment.


You may put blank lines anywhere you wish in an input file.


Finally, you may block out a range of lines in an input file as commentary by beginning the first line with ‘/*’ and the last line with ‘*/.’  An example of an input file that uses these devices appears below.
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/*  This is an example of a LIMDEP input file. The commentary      

     is assumed to continue until we end it with a star then a slash.    

     (Not yet.)  The first command in this file is going to open a       

     file for the program output.                                */   

     Open  ;  Output  =  DEMO.OUT $                                      

 /*  The next line will read a data file.                        */   

     Read  ;  File  = DEMO\DEMO.DAT  ? Read is for files on disk         

           ;  Nvar  = 3              ? Number of variables               

           ;  Nobs  = 50             ? Number of observations            

           ;  Names = 1 $            ? Names at the top of the file      

     Sample;  1‑50 $                                                     

 /*  Compute some transformed  variables. */

     Create  ;  x1x2  =  x1 * x2  ; x1sq = x1^2 ; x2SQ = x2^2  $         

 /*  Now, we fit the 2 regressions. First linear, then log‑linear. */  

     REGRESS, Linear    ; Lhs = y ; Rhs = one,x1,x2,x1sq,x2sq,x1x2  $    

     REGRESS, Loglinear ; Lhs = Log(y) ; Rhs = one, Log(x1), Log(x2)$   


To submit an input file as a series of commands to be executed, select Run:Run File… from the main menu to reveal a dialog box such as the one in Figure 3.16.:
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                           Figure 3.16.  Run File Dialog Box

The file you select is then submitted to LIMDEP, as if it were a series of commands that you had submitted from the editor.

You may find it useful to move a text file into the editor.  You can upload any text file by activating the editor window, and placing the insertion point where you wish the file to be inserted. Then, select Insert:Text File from the main menu.  You can then find your way to, and insert any text file you like.  Thereafter, you can execute any or all of the command lines.

TIP:  The dialog box shown in Figure 3.16 is a Windows mini-explorer.  You can launch a program, move a file, or delete a file or a folder by operating on the entries in the box.  It might sometimes be helpful to see the items in the box in details mode rather than in list mode.  Do this by clicking the button at the upper right of the dialog box.  This is shown in Figure 3.17.
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                       Figure 3.17  Run File Dialog Box in Details Mode

3.6.1  Batch Mode – Using Command Files

LIMDEP does not provide a true batch mode, in which you start the program from some kind of command line and then collect the output in a file later.  But, operation from the text editor can produce the same result.  You may open as many input and output files as you wish from the editor.  Figure 3.18 illustrates.
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       Figure 3.18  Editing window set up for batch mode operation

With the setup shown above, you could highlight all lines in the window then with GO, invoke three sets of commands, the two projects shown followed by the commands at the bottom of the window which are directly in the command stream.


Note that there are two ways to open separate output files for these projects.  The first project (command file) contains the command to open its specific output file.  The output for the second command set is opened by a command that appears in the editing window.

WARNING:  In principle, a command file could open another command file.  But, you should not do this.  Control will never return to the first command file.  When the second command file is finished, LIMDEP will return to the editing window for the next command.

3.7.  Work Areas and Projects


When you operate LIMDEP, your primary purpose will be to analyze a data set. LIMDEP provides a number of ‘work areas’ in memory. One of them is the ‘array’ where your data are stored. However, whether you make explicit use of them or not, there are a number of other work areas being maintained for you.  It is useful to know about them while you use the program, especially when you approach the limits of their capacity.  To summarize, the various entities that you will accumulate and use as you operate LIMDEP include:

(  Raw data:
The data area.

(  Matrices:
Your matrix work area.  Your models keep matrix results.

(  Scalars:
A bank of named scalars, created by you or by model estimation.

(  Namelists:
Names that can be used to represent up to 100 other names.

(  Procedures:
Possibly large groups of commands that can be submitted at once.

(  Tables:
The results of previous models that you have estimated.

In each of these cases, there is a set amount of information that can be stored.  You can navigate the project window to find out what entities you have defined and how much room you have left in each of your work areas. 

3.7.1.  Work Areas

Data Area


The initial setting is 200,000 cells (values) when you start LIMDEP.  With 200 variables, this allows 1,000 observations.  This is a global setting that you can change if necessary.  There are two cases to consider, as shown in Figures 3.19a and 3.19b:

(1)  To reset the data area size just for the current session, Select Project:Settings…/Data Area.  You can set the dimensions of your data area as needed.  In the discussion below, this total size of the data area is referred to as NKMAX.  You are not limited by the physical size of the computer, as Windows can swap data from disk to memory as necessary.  Note that setting this parameter brings a global program reset.  All data are erased.  But, this setting is only for the current session.

(2)  To set the data area size permanently, select Tools:Options/Projects.  This sets the default data area size permanently (or until you change it again), so that this will be the setting every time you start LIMDEP.
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Figure 3.19a  Project Settings Data Area          Figure 3.19b  Tools Options Default Data Area
Rows and Observations


The number of rows in the data area is the integer part of NKMAX/200.  This is only the default.  If you need more rows, the adjustment is made at the time you READ your data.   The number of columns that can be accommodated in the now fixed NKMAX can be adjusted downward if the number of rows is excessive.  (200 is a hard upper limit, however.)

Data Type

This is Undated for a cross section.  You may specify monthly, quarterly, or yearly for time series data instead.  Two ways are to use the DATA command or to select Project:Settings…/Data Type from the desktop menu, and choose the type you wish in the dialog box shown in Figure 3.20.  When you choose one of the time series options, only one of the initial date entries is provided.
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                             Figure 3.20  Project Settings Data Type

Variables
 
You may have up to 199 variables.  The 200 includes one, which LIMDEP reserves for itself. 

Namelists

You may define up to 10 of these, each standing for up to 100 names.  See the documentation of the NAMELIST command in Section 7.3 for details.

Matrices

You may have up to 100 matrices in a work area that contains 175,000 cells.  LIMDEP reserves three of these, and 25,000 cells for your model results.  This may seem small for possibly large X matrices, but, in fact, given the way LIMDEP does matrix algebra, you will find it difficult to approach this limit, even if you are manipulating tens of thousands of observations.

Scalars

You may define up to 50 of these, though LIMDEP reserves 14 for itself.

Procedures

You may define up to 11 of these, 10 in a library and one as the ‘current procedure.’

Tables

You may store for later output to a file the results of 10 models.  These may be examined by using the REVIEW command.

3.7.2.  The Project Window


Your project window is the leftmost window in Figures 3.1 and 3.4.  At any time, you can find an inventory of all of the preceding in the project window.  Figure 3.21 shows an example based on the editing window shown in Figure 3.5.  There is an inventory of the existing data entities, and a display of some of them (matrix varb and scalar rsqrd at the bottom of the project window). The displays are obtained by double clicking the names in the window.
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  Figure 3.21.  Project Window and Output Window


Note in Figures 3.1 and 3.4 that the Variables, Matrices, and Scalars (as do the other table entities) appear as closed folders.  By single clicking on [image: image27.bmp] next to the folder titles, such as Variables, you can expand them to display the lists of items in the tables.  By double clicking on items in the tables, you can display the individual items or in several cases, edit them.  There is a tremendous amount of functionality built into the project window.  The following lists these functions:  The list is based on an expanded version of the project window shown above:


There are four major groupings in the project window.  Their titles and contents are:



Title                  Contents                                                                                 


Data

Variables, namelists, matrices, scalars



Strings

A set of three character strings that you can define



Procedures
Up to 10 named and one unnamed groups of commands



Output

Output window, model table

Note in Figure 3.1, that some titles are shown preceded by [image: image28.bmp], indicating that by clicking this title, it will be expanded to reveal its contents.  Some are shown with a [image: image29.bmp] to indicate that they are already expanded, and one (procedures) has neither [image: image30.bmp] nor [image: image31.bmp] which indicates that there are no procedures to display by expanding this topic.  Figure 3.20 shows a more detailed example.  All four groupings are expanded in this project window.  You have the following additional functions available in the project window:  To open any of these groupings, you can simply the [image: image32.bmp] or [image: image33.bmp] next to the group name.

Data Grouping:

(  Data:  Click the group title to display the four folders in this group.
(  Variables:  Click the group title to see how many variables currently exist and how many

    columns there are in your data area. 

(  Any Variable:  Double-click any variable name to open the data editor to edit that variable and

    others that exist at that time.

(  Namelists:  Click the group title to see how many of the 10 available namelist definitions have

    been used.

(  Any Namelist:  Double-click any namelist name to enter the namelist editor which will allow

    you to edit this namelist by adding or deleting variables.

(  Matrices:  Click the group title to see how many of the available 100 matrices have been defined

(  Any Matrix:  Click any matrix name to see the dimensions of that matrix displayed at the bottom

   bottom of the project window.

(  Any Matrix:  Double-click any matrix name to enter an editing window that shows the full

    matrix and allows you to edit it and save the changes.  (B and VARB cannot be changed.)

NOTE:  There are various items in the project that are “read only.”  These correspond to the reserved names listed earlier.  You will know that an item in the project is read only by its identifying key marker, [image: image34.bmp].  This marker indicates an item that you can view in one of the various editors, but cannot change.

(  Scalars:  Click the group title to show how many of your changeable scalars remain available.

(  Any Scalar:  Click any scalar name and the value it currently takes will be displayed at the

    bottom of the project window

(  Any Scalar:  Double-click any scalar name to enter an editing window which will allow you

    to replace the value of the scalar.   Note that the first 14 scalars are read only.

(  Any Variable, Matrix, Scalar, or Namelist:  Highlight the name of the entity, then press Del to

   delete the item from the work area.  This may be necessary to clear space.
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Figure 3.22.  Project Window

Strings Grouping:

(    Strings:  Click the group title to open an editor for editing the three available strings.

(See Section 37.4.2 for use of these character strings.)

(    Strings:  Double click any of the string names to enter an editing window that allows you to

      define the character string.

Procedures Grouping:

(    Procedures:  Click the group title to see how many of the 10 procedures are available.

(    Procedures:  Double-click the group title (or open the folder) to display the names of the

     defined procedures.

(    Any Procedure:  Click a procedure name to display how many lines of commands are in this

      procedure, of 50 that can be used.

(    Any Procedure:  Double-click any procedure name to open an editing window in which you

      can edit that procedure and, if you wish, change its parameter list.

Output Grouping

(   Output:  Click the group title to display the two items in the group, tables and output window.

(   Tables:  Click the group title to display the names (up to 10) of the models that you have

     stacked in the results table work area.

(   Any Table Name:  Double-click any name in the tables grouping to open the editing window

     where you can construct output tables for model results.

(   Output Window:  Click this window entry to activate the output window.

TIP:  You can select (highlight) any name in the project window, then drag that name into the editing window if you would like to use the name in constructing commands.  Another way to copy a name from the project window into the editing window is to use Ctrl-Click - that is, put the mouse cursor on the name you wish to copy, press and hold down the Ctrl key and click the left button on your mouse.  (You will have to add the commas to separate the names.)  This will allow you to assemble a list of names in the editing window quite quickly.

Other Functions in the Project Window


Many other editing features are built into the project window.  By selecting any name in this window with a right button click, you obtain a menu of features.  These are:

Variable:
Data editor, Rename the variable, Sort the variable, Copy the name to the editing



window.  Delete the variable

Namelist:   
Namelist editor, Delete the namelist, Copy the name to the editing window

Matrix:     
Matrix editor window, Delete the matrix, Copy the name to the editing window


     
(When in the matrix editing window, right click allows you to add rows or

 

columns to a matrix.)

Scalar:      
Scalar editor/new entry, Delete the scalar, Copy the name to the editing window 

                
(When in a scalar editing window, right click invokes an editing menu.)
String:      
String editor, Copy the name to the editing window

Procedure: 
Edit the procedure, Run the procedure, Copy the name to the editing window
Table:       
Editor, Review output tables, Add tables to output.

We’ll revisit these features at appropriate points later in this manual.
The Insert:Item into Project Menu


The Insert menu includes an option, Item into Project, that offers dialog boxes for creating all of the major data entities that exist in your session, variables, scalars, matrices, namelists, and procedures.  Each of these is an editor that allows you to edit an existing entity or to create a new one.  See Figure 3.21, above.
3.8.  Program Output and the Output Window

3.8.1.  The Windows Output Window


LIMDEP will automatically open an output window and use it for the display of results produced by your commands.  Figure 3.24 below shows an example for the commands that are in the editor in Figure 3.5.  The output window is split into two parts.  In the lower part, an echo of the commands and the actual statistical results are accumulated.  The upper part of the window displays the TRACE.LIM file as it is being accumulated.  Note that there are two tabs in the upper window.  You have two options for display in this window.  The Trace display is as shown below.  If you select the Status tab, instead, this window will display technical information during model estimation, such as the iterations, line search, and function value during maximum likelihood estimation, and execution time if you have selected this option from the Project:Project Settings/Execution tab as well.  We will review the Status tab in Chapter 11 where we discuss the optimization procedures.
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    Figure 3.24.  Output Window

3.8.2.  Opening an Output File


You can open an output file if you wish - see Section 8.4.  The command is




OPEN ; Output = the desired filename $

All the model results that are sent to your output window will be echoed to this file.  One difference is that the file will not contain the interleaved commands, as appear in the example above.
HINT:  It is not necessary to open an output file to retain your results during your session.  As you exit LIMDEP, you will be asked if you wish to “Save changes to <title of output window>?”  At this point, if you answer yes, you will be able to create an output file.  You will be queried for the name.  The file will contain all of the results that have been accumulated during your session.

3.8.3.  Editing Your Output - Edit: Cut, Paste, and Copy


The output window provides limited capability for editing.  You can select, then delete any of the results in the window.  You can also highlight then use Cut or Copy in the output window.  (The right mouse button also brings up a limited menu for editing the output window.)

But, there is a way to get full editing capability.  You can select, then cut or copy the material from the output window and move or copy (paste) it into an editing window (or into any other program, such as a word processor, that you might be using at the same time).  The editing window then provides full editing capability, so you can place any annotation in the results that you like.  You can save the contents of the editing window as an ordinary text file when you exit LIMDEP.

TIP:  If you wish to extract from your output window a little at a time, one approach is to open a second editing window, and use it for the output you wish to collect.


The usual Edit:Cut, Copy, and Paste features are available in both the editing and output windows.  You can select text, commands, or any output, and copy it to the Windows clipboard, then into any other application, such as a word processor or spreadsheet program.

3.8.4.  Printing


As noted earlier, printing with LIMDEP is handled by your Windows print manager.  Also, you will generally do relatively little printing during your LIMDEP session, and, probably, relatively little printing with LIMDEP at all – most results will go to a file on your disk, or can be pasted into word processing programs that can be used to process results for final output.


The File menu does provide you with some control over how LIMDEP results are to be printed from the program.  The File:Page Setup dialog is shown in Figure 3.25.
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  Figure 3.25   Page Setup Dialog

3.9.  HELP


LIMDEP includes an extensive file that includes, among many other topics, nearly 75 percent of this entire manual.   Select Help:Help Topics from the menu to bring up the help editor. LIMDEP’s help file is divided into eight parts, or ‘books.’  In the first book, you will find a selection of Topics that discuss general aspects of operating the program.  The second book is the Commands list. This contains a list of the essential features and parts of all of LIMDEP’s commands.  The third book contains the entire text of this LIMDEP User’s Manual, minus some of the technical results and applications in the model chapters.  The fourth book contains an expanded version of the desktop summary that appears in Section 3.10.  The fifth book contains descriptions of updates to LIMDEP that were added after the manual went to press.  Finally, there are three books of useful ancillary material: a collection of LIMDEP programs, some of which appear in this manual, a collection of data sets that can be used for learning how to use LIMDEP and for illustrating the applications - these include the data sets used in the applications in this manual, and, finally, some of the National Institute of Standards accuracy benchmark data sets.

Many of LIMDEP’s features include context sensitive access to the Help file.  You’ll find these in the menus indicated by a [image: image38.bmp] button in the menu.  For example, The editing window includes a window for inserting a “function” (verb) as shown in Figure 3.26.
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                  Figure 3.26  Editing Window with Name Insertion

The “function” button, [image: image40.bmp] invokes a dialog box that allows you to insert any of the LIMDEP verbs at the insertion point.  The dialog box is shown in Figure 3.27.
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            Figure 3.27 Insertion Dialog Box

This dialog box offers a full list of the LIMDEP commands broadly grouped by function.  By pressing the [image: image42.bmp] at the lower right, you can request the online manual selection for that verb, as shown in Figure 3.28.
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                   Figure 3.28  Help Screen for CREATE Command

3.10.  A Summary of Commands

This section will summarize the functions and commands available in LIMDEP.  The listing given will suggest the range of procedures available.  Most of the procedures listed here have numerous options, so this is merely an overview.  

(  Environment
EXIT

Exit the program. 

HELP 

Help:Help Topics.

STOP 

Exit the program. Use File:Exit.

(  File System

CLOSE 
Close an output file before opening a different output file.

LOAD

Retrieve saved data set to reactivate program. Use File:Open.


(LOAD;File=filename$ may also be used.)

SAVE 

Store all data currently active in a file; used with LOAD.  Use File:Save… 

(  Managing the Work Areas
DELETE
Delete variables. Clear space in the data work area.  In the Windows program, 



can also be done by highlighting a variable in the project window and using



Del. You can also delete matrices, scalars, and namelists this way.

LIST 

Display variables on the screen.  Inspect columns of data.  Can also be done by



double-clicking a variable name in the project window to open the data editor.



The data editor can also be opened by clicking on the grid (spreadsheet) icon in

 

the toolbar.

NAMELIST 
Identify a list of variables with a name.  The namelist editor can be opened



from the project window by double-clicking any namelist name.

RENAME 
Change the names of one or more variables.

RESET 
Delete all data of all types and restart session.  Can also be done from the desktop



menu using Project:Reset…
(  Creating and Executing Procedures

Procedures can be edited in a procedure editor by double-clicking any procedure name in the project window.  You can also begin entry of a new procedure in the procedure editor by using

Run:New Procedure…

DEBUG
Mode of execution. Pause between commands and query for continue.

DOFOR
Execute a procedure for certain values of a variable.

DOUNTIL
Execute a procedure until a certain condition is true.

DOWHILE
Execute a procedure while a certain condition is true.

ENDDO
End of target procedure for DOWHILE, DOFOR, and DOUNTIL.

ENDPROC
End entry of commands in a procedure.

EXECUTE 
Execute stored procedure.  You can also execute a library procedure.

FAST 

Execute procedure without pausing between commands.

GO TO   
Redirect the flow of execution of a set of commands.

LABEL 
Mark a point in a set of commands. Use with GO TO.

NODEBUG
Resume normal mode of execution.  Turns off DEBUG switch.

PROC

Begin entry of commands in a procedure.

SILENT 
Execute a procedure without displaying results.

SLOW

Turn off FAST switch.

NOSILENT
Turn off SILENT switch.

STRING
Define ‘macros’ for routines. Shorthand for a string of text.

EDIT 

Edit stored procedure.  This is a multipurpose text editor.

(  Creating New Variables
CREATE 
Transformations of variables.  You can also enter transformations interactively.



Enter the data editor by any of the means available, then, click the right mouse


button.  In the menu that comes up, select New Variable... to enter a window



which will allow you to enter CREATE commands interactively.
RECODE 
Replace values of a variable with other values.

SORT 

Sort a variable, possibly carrying others.  (Highlight a name then right click.)

(  Manipulating Numeric Entities - Matrices and Scalars
CALCULATE Compute scalar result.

MATRIX 
Matrix algebra package.

These two procedures can be accessed from the main menu with Tools:Scalar Calculator or

Matrix Calculator.  Once in one processor, you can also switch directly to the other.

(  Entering a Data Set
APPEND
Add additional observations to existing variables.

DATA

Invoke interactive data editor.  There are several ways to reach the data editor,



including double clicking any variable name in the project window, selecting



Project:Data Editor, or selecting the data editor from the toolbar.

READ

Read a data set into the data work area from a file.  You can also read a data



set by entering the data editor, then clicking the right mouse button.  When the



next menu comes up, select Import Variables…
ROWS 
Configure number of rows in data area.  Use Project:Settings/Data Area.

WRITE 
Write a data set in a disk file.  Use the command or Project:Export:Variables…


from the main menu.

(  Labeling Statistical Output
REVIEW
Examine previous statistical results and create tables.  Review can be reached



by clicking any of the tables in the project window or by selecting



Tools:Review Tables in the main menu, or directly in the project window.

TABLE
Create tables of results in an output file.

TEXT 

Send text to an output file.

TIMER 
Display elapsed time for each model command.  The switch can also be set with



Project:Settings/Execution.

TITLE

Define page header for model commands.

TYPE 

Send a message to screen and output file.

(  Defining the Sample to be Used for Estimation
DATES
Define type of time series data, quarterly, yearly, etc.  Use the command or



Project:Settings/Data Type.
DRAW

Draw a random sample.  Also allows bootstrap sampling.

INCLUDE 
Add observations to sample.  INCLUDE and REJECT can also be specified



by using Project:Set Sample from the main menu.



NOSKIP
Turn off SKIP switch.  Can also be reached by Project:Settings/Execution.





SKIP switch can also be turned on this way.

PERIOD 
Define sample period for time series data.  Can also be done with



Project:Set Sample from the main menu.

REJECT 
Delete observations from sample.

SAMPLE 
Specify observations in the sample by observation number.

SKIP 

Set switch so LIMDEP automatically skips missing data.

(  Model Commands
ARMAX  
Box-Jenkins ARIMA models.

BIVARIATE PROBIT  Bivariate probit models.

BTOBIT 
Bivariate tobit models.

BOXCOX  
MLE or nonlinear least squares for Box-Cox model.

CROSSTAB  
Cross-tabulation. Frequency counts and contingency tables.

DISCRETE CHOICE or CLOGIT Random utility models and nested logit models.

DSTATS  
Descriptive statistics.

FINTEGRATE  Integrate a function over a given range.

FPLOT  
Plot values of a function of a variable.

FRONTIER REGRESSION  Stochastic frontier.

GROUPED DATA REGRESSION  Completely censored data.

HISTOGRAM
HREG 
 
MLE for heteroscedastic regression model. Var[e] = exp(a’zi).

IDENTIFY  
Plot autocorrelations and partial autocorrelations.

INCIDENTAL TRUNCATION  A form of selection model.

KERNEL  
Kernel density estimation and nonparametric regression

LOGIT  or MLOGIT Binomial or multinomial logit model.

LOGNORMAL REGRESSION
MAXIMIZE  
Maximize a user defined function.

MINIMIZE  
Minimize a function or compute nonlinear least squares estimates.

MPLOT  
Plot elements of one matrix against those of another.

MPROBIT 
Multivariate probit model.

MSCORE  
Maximum score estimation for binary choice data.

NEGBIN  
Negative binomial regression models.

NLOGIT  
Nested logit and conditional logit models.

NLSURE  
Nonlinear seemingly unrelated regressions.

NPREG  
Nonparametric regression estimator for binary choice data.

NTOBIT  
Two level, nested tobit models.

ORDERED PROBIT  Ordered probit or logit models.

PROBIT  
Univariate probit model.

TOBIT  
Censored regression.

TRUNCATED REGRESSION
PLOT  

Scatter diagrams and time series plots.

POISSON  
Poisson and negative binomial regression models.

REGRESS (or OLSQ, CRMODEL)  Classical regression. Least squares regression.

SELECTIVITY  Sample selection models.

SPECTRAL 
Plot and compute spectral density function

SURE  

Seemingly unrelated and multivariate regression.

SURVIVAL MODEL  Analysis of duration data.

SWITCHING REGRESSIONS
TSCS  

Time series/cross section regressions.

WALD  
Test restrictions or obtain variances for nonlinear functions.

2SLS  

Two stage least squares.

3SLS  

Three stage least squares.

3.11.  Summary of the Windows Desktop


When you operate LIMDEP you will generally be using the set of windows shown in Figure 3.27, which is a somewhat abbreviated composite of the various features that you will find on your screen.  This section of the documentation will briefly describe all of the different parts of the desktop. In the sections to follow, we will describe

(  The four windows,

(  The main menus shown at the top of  the screen,

(  The toolbar shown below the main menus,

(  The command window below the tool bar,

(  The correspondence between the menu items and the commands listed earlier.
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Figure 3.29    Windows Desktop
3.11.1.  The LIMDEP Windows


There are three main windows on the desktop.  Operation begins in the project window, which is at the upper left of the desktop.  The project window contains a complete accounting of the data, matrices, procedures, and so on, that you have created during your session.  By clicking the different topics in the project window, you can review the variables, matrices, etc. that exist at any time.  In addition, you can launch many different operations from the project window.


Most of your command input is done from the editing window, which is at the upper right of the desktop.  Model commands and data manipulation commands will usually be placed on the screen in this window, then executed by one of several methods.  The simplest way to proceed until you are ready to use the more advanced features is to place the commands you wish to execute in the window, highlight them using your mouse, then click the green Go button, which is the sixth  button from the left on the toolbar (under Tools). There are many options available for editing in this window, including two of the main menus, Edit and Insert.

Your statistical results and a trace of your session are accumulated in your output window.  This is the larger window at the lower right of the desktop.  We have compressed it for the display.  The output window is a split screen.  The statistical results are shown in the lower half.  The upper part has two tabs.  If you choose Trace, a continuing trace of your commands, diagnostics and error messages that your commands produce, and other useful information are listed in the top half of the window.  This information is also saved at the end of your session in the LIMDEP trace file, TRACE.LIM.  If, instead, you have chosen the Status tab, the top half of the window will display certain technical output generated during model estimation, such as values of the log-likelihood, convergence criteria, and timing information.  The trace will continue to accumulate in the background.


The smaller window at the center of the desktop is a calculator window.  You may, in fact, have more than one of these open at any time, though typically, using just one is optimal.  The calculator window is an interactive session with CALCULATE and/or MATRIX.  Results that  you wish to obtain interactively rather than as part of a command in a procedure, can be obtained by entering one of these windows.  The window contains its own input field, at the top, labeled Expr for expression.  You can enter any valid CALC or MATRIX command in this field.  The result will be shown in the lower field.  The window shown in the figure is being used for CALC.  You can switch over to MATRIX by clicking the optional field at the right of the top row - this is the downward pointing arrow next to the window containing ‘Scalar.’  Thus, you can accumulate both matrix and scalar results in this window.  (Matrix results are shown as an object, rather than the full matrix, itself.  By clicking the object, you can enter a display of the matrix, itself.)  Finally, the button labeled fx will call up a selection of functions that you can insert into your expressions for both CALC and MATRIX.

3.11.2.  The Main Menus

The nine menus at the top of the desktop provide the following functions:

File Menu

File



Opens and closes project files (LIMDEP sessions)
   New...     
Ctrl+N 

Opens a query for beginning a session in the editing window

The choices are Text/Command Document or Project
   Open       
Ctrl+O

Opens a file into project, editing, or output window.
   Close          


Closes the active window. (You are asked for confirmation.)

((((((((((((
   Save       
Ctrl+S 

Saves the active window (project, editing, output).
   Save As...         

Same as Save.

   Save All   
             
Saves all windows.
 ((((((((((((
   Open Project...    

Opens window to find a project file.  Same as Open.





Same as LOAD ; File = filename $

   Save Project As... 

Same as SAVE ; File = filename $

   Close Project       

Same as RESET $

((((((((((((
   Page Setup...      

Sets up printing for output window.  Size, portrait/landscape, 

  


margins, printer identity, port.  Also sets up graphics output.

   Print Preview      

Displays on the screen what printed output will look like.

   Print...     
Ctrl+P

Standard Windows print operation, to print output window.

  ((((((((((((
  1 Name of previous .lim
Opens this command file.  Names of previous command files

     file used


that were opened by file name will appear here, in the order in

  2 data, command, or other 
which they were used.

  3 recently used file       



  4 ...                      

((((((((((((
  5  Recent Project

Opens the most recently used project file.  Lists up to four 





recent projects.

  6 …

((((((((((((
  Exit        
 Alt+F4 
Exits LIMDEP. You are queried to save project, output, and

editing windows (.LPJ, and .LIM file types) and any

calculator, matrix, and plotting windows that are still open.

Edit Menu

Edit 



Standard editing features when in the editing window.
  Undo           
Ctrl+Z     
Undoes the last operation, for example, replaces deleted text.

  Cut           
Ctrl+X     
Removes selected text and puts it in the clipboard.

  Copy           
Ctrl+C

Copies selected text to the clipboard, without deletion.

  Paste          
Ctrl+V     
Copies last cut or copied text to insertion point.

  Clear           
Del        
Erases selected text in the output window or the trace window.

  Delete          


(Not used)

  Select All
Ctrl+A     
Selects (highlights) entire editing or output window.

  These editing features also operate in the output window. Del (key) also deletes a selected item

  in the project window.

((((((((((((
  Include Observations Ctrl+add
Set up an INCLUDE command in a window

  Reject observations   Ctrl+subtract
Set up a REJECT command in a window

((((((((((((
  Find



Finds a particular character string in the editing window.

  Find Next   
F3

Repeats the last find operation.  Finds next occurrence.

  Replace


Replaces a character string with another character string.

  Go To...       
Ctrl+G

Moves insertion point to a particular line (by line number).

  Object          


(not used)
Insert Menu
Insert



Inserts items at the insertion point in the editing window.

These features operate on the text editing window to help build

commands. You can insert verbs (command names), file paths,

or entire ascii text files at the insertion point

  Command


Inserts a command (verb only) at the insertion point.  A

window presents the list of verbs to select from.

  File Path...           

Inserts the full path to a file on your hard disk at the insertion

point. Used in commands such as OPEN and WRITE.

  Text File...        

Inserts a text file at the insertion point.  You can put the entire





contents of a file in the editing window. The file can be added

to the existing text or put into an empty screen for editing or

for execution as an input file.

((((((((((((
  Rows  


Opens up rows at insertion point in the data editor (not the

text editor).  This puts one or more empty rows at the insertion

point in the data editor.  Data are pushed off the stack.

  Columns        

(not used)

((((((((((((
  Item into Project…

Inserts an item into project.  Computes a new numerical entity.


Variable 

CREATE a new variable.


Matrix


MATRIX command for a new matrix.

Scalar


CALCULATE command for a new scalar.

Procedure

Enters a procedure editor to create a procedure.

Namelist

Enters a namelist editor for new or existing namelists.

Project Menu

Project



Used for several functions of managing the data as well as a





number of other features of the program.

  Settings…       

Offers a window with tabs for parameter and switch settings.
 Data Area       
Memory allocation: chooses number of cells in data area.

                            
Dimensions: chooses number of rows in data area. Same as

ROWS command.

            Data Type   

Observations:  Chooses data type, Cross section (undated)

or time series (dated).  Same as DATES command. Initial Date:

Year, quarter, or month if  time series data.

Execution  

Models:  SKIP switch. on or off.

Output


Turn  SILENT on or off to suppress output

TIMER switch on or off to display time used in estimation
((((((((((((
  New (           

Creates five new numerical entities - variables, etc.  These

open windows that operate like the individual commands, but 

in interactive, rather than command mode.

  Variable…    

Interactive create window.


Namelist… 

Interactive namelist editor.

  Matrix…   

interactive matrix window.

  Scalar…      

Interactive calculator window.

  Procedure…

Procedure editing window.

  Import (      
Variables   
Finds a data file by opening a search window. Same as READ.

  Export (      
Variables   
Writes variables in a data file. Formats include .XLS, .WKx, 




.DAT, and binary (.BIN).  Same as WRITE.

  Data Editor                    
Goes to data editor – spreadsheet style display.

 ((((((((((((
  Sort Variable...

Sorts a variable, carrying one or more other variables.  Same





as SORT ; Lhs = variable to sort 

   



   ; Rhs = variables to carry $  ; Ascending optional.
 ((((((((((((
  Set Sample(

Sets the current sample to be all observations.

All


Same as  SAMPLE ; All $
 
Range...   

Observation rows:  Queries for observations to be in the

current sample.  Same as SAMPLE; range $ for cross section

data or PERIOD ; First - Last $ for time series data.

Include...  

Queries for New and enters command (expression).  Same as

INCLUDE ; Expression $ with ;New optional.

            Reject...   

Queries for New and enters command (expression).  Same as

REJECT ; Expression $ with ;New optional.


Draw...


Draws random samples from your data set. Same as 

DRAW; Nobs [ ; Replacement] $

((((((((((((
  Reset...                        
Erases all variables and matrices.  Same as RESET $

Model Menu

Model is used to invoke a dialog which helps beginning users set up model definitions:
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Finally, each specific model has associated with it a “command builder” which you can use to specify a model interactively.  The dialog then produces two or three windows which offer the options available for that modeling framework.  For example, the Regression… command builder screen contains the main and options menus:


(The third window, for specifying options, is not shown.)  The command builder will be discussed further in Chapter 12.

Run Menu

Run



Executes groups of commands highlighted in the editing 





window.

  Run            
Ctrl+R       
Executes highlighted commands.  Same as Go button.

  Run Multiple Times...          
Executes highlighted lines more than one time.

  Run File…                       
Executes the commands in a file.  Same as

OPEN ;Input = filename $ Queries for filename.

  Run Procedure

Execute a procedure stored in the procedure library.

  Stop Running Ctrl+Break
Interrupts input of a file or execution of commands from the 





editing window.

((((((((((((
  New Procedure   

Opens procedure editor. Saves procedure on exit.  Procedures

may be
named and have adjustable, replaceable parameters.

Tools Menu

Tools



Interactive (conversational) execution of certain commands such

as CALC and MATRIX.

  Scalar Calculator  

Opens a calculator window for scalar calculations.  Same as




CALCULATE command.  You can toggle to the matrix 

calculator from this window.  Results are shown on the screen.

  Matrix Calculator   

Opens a calculator window for matrix calculations.  Same as




MATRIX.  You can toggle to the scalar calculator window from

this window.  Results are displayed on the screen.

  Review Tables...              
Constructs tables of statistical results.  Model commands that




contain ;Table=name accumulate results in the model stack

that are reviewed here and can be grouped in tables in the output

output window.
((((((((((((
  Options... 


Several settings for program execution and display.

View 


Displays toolbar at top of desktop.

Displays program status bar at bottom of desktop.

Editor    

Choose font for editing and output window.  Chooses among

all available fonts.  Automatic word selection.  Handling of

highlighting in text editor.

Projects  

Main memory allocation for data area.  Same as RESET.

Execution

Output window moves to front during execution.

Preferences: faster execution or greater user interface

 



responsiveness


Trace


Indicate where to save trace file TRACE.LIM 

Window Menu

Window


Handles display of windows on the desktop.

  Split                          
Sets sizes of parts of split output window.

((((((((((((
  Cascade                        
Arranges active windows in cascade display format.

  Tile         


Arranges active windows in tile display format.

  Arrange Icons                  
Arranges icons at bottom of desktop.

((((((((((((
  Output                         
Activates output window.

 ((((((((((((
  1  Name of project window
Activates any of these windows.

  2  Name of edit window

  3  Name of output window

  4  Name of a calculator window and so on

Help Menu

Help

   Help Topics


Activates LIMDEP HELP program. 

   Tip of the Day

Suggestions for operating LIMDEP.

   LIMDEP Web Site      
If you have a web browser active, sends web browser to




LIMDEP home page.

   About Limdep   

Information box

Other menus include the following:

Icon Menu

Clicking the icon at upper left corner of an active window produces the following menu: 

Restore


Restores window after it has been minimized.

Move


Repositions window on screen.

Size


Changes size of window.

Minimize

Reduces window to icon on taskbar
Maximize

Expands window to fill desktop.

Close 
Ctrl+F4
End task in window.  Usually minimizes, rather than exiting.

Next 
Ctrl+F6
Next window. Cycles among project, editing, output





(calculator, if open) windows.

Right Mouse Button Menu

Clicking the right mouse button when mouse cursor is not in a window opens this menu:


New…



Same as File:New

Open…


Same as File:Open

Project



Activates project window


Data Editor


Activates data editor window

Output



Activates output window

Options…


Same as Tools:Options

3.11.3.  The Toolbar


There are fourteen tools shown in the toolbar in the second line of the desktop. 
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 These are equivalent to certain other menu entries, as follows.  The buttons are listed below in the order from left to right:

   1.  Open a new editing window. (File:New)

   2.  Open an existing file.  (File:Open)

   3.  Save   (File:Save)

   4.  Print  (File:Print)

   5.  Cut selection to clipboard  (Edit:Cut)

   6.  Copy selection to clipboard (Edit:Copy)

   7.  Paste selection from clipboard to insertion point (Edit:Paste) 

   8.  Insert a command at the insertion point (Insert:Command)

   9.  Execute selection (Run:Run)
  10.  Stop commands (Run:Stop)

  11.  Pause commands.  Interrupt file or editor execution.


12. Activate project window

     
13.  Activate data editor

14.  Activate (and open if necessary) output window.

3.11.4.  The Command Window


The command window appears below the toolbar.  By placing the insertion point in this window, you can enter your commands one at a time.  This is for one line commands.  The command is submitted when you press Enter.  The window accumulates a menu of your commands, which is recalled by pressing the down arrow button at the right end of the command window.  The fx button invokes the Insert menu.
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3.11.5.  Commands and Menu Items


Several commands are equivalent to the menu items listed earlier. Also, in some cases, there is more than one menu item which corresponds to the particular command.  The correspondences are listed below.

CALC   

Tools:Scalar Calculator or toggle from the matrix calculator window

CREATE  
In data editor, right button, New variable.  Project:New Variable
DATES   
Project: Settings/Data Type
DELETE  
Highlight name in project window then press Del

INCLUDE 
Project:Set Sample:Include, Edit:Include Observations
LOAD    
File:Open, or  File:Open Project, (any project shown in submenu)

MATRIX
Tools:Matrix Calculator or toggle from the scalar calculator window
NAMELIST 
Double-click existing namelists in project window to edit a namelist, or




Project:New… Namelist

OPEN

Input file, Run:Run File
OPEN 

Output file.  Save output window at exit. 

PERIOD   
Project:Set Sample:Range  enter dates (set DATES to time series)

READ     
Project:Import:variables...
REJECT   
Project:Set Sample:Reject, Edit:Reject Observations

RESET    
Project:Reset

REVIEW   
Tools:Review Tables
SAMPLE   
Project:Set Sample:Range

SAVE    
File:Save, Save As, Save Project As

SILENT   
Project:Project Settings/Execution:Show output text (disable)

SKIP/NOSKIP
Project:Project Settings/Execution:Skip... (enable/disable)

STRING   
Double-click any string in project window to enter editor

TIMER    
Project:Project Settings/Execution: to show execution time

WRITE    
Project:Export Variables
1.   Start the program





          We assume that you have successfully installed LIMDEP on your computer and created a shortcut to use to invoke the program.  (Obviously, yours won’t look quite like ours.)  Now, invoke LIMDEP, for example, by double clicking the shortcut icon, as shown in the top row  in Figure 3.9.


         Your main LIMDEP desktop will appear, as in Figure 3.10.  (There will be at least one difference.  Until you change the setting, the default number of rows in your data set will be 1,000, not 20,000.  This is of no consequence at this point.) Note that the project is untitled and, in fact, at this point does not contain any data.











�





Figure 3.23  Insert Item Into Project











The initial menu offers a grouping of the available LIMDEP modeling frameworks.  Each of these contains a number of more specific model commands.  For example, the Linear Models grouping includes
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